Welcome to Exchange Mail

Customer Full Name________________________________

Your e-mail is now being delivered and stored on the new Exchange server. Your new e-mail address is ____________@rit.edu. This is the e-mail address that you should give out to your contacts.

This document will explain some of the features of Exchange as well as instructions for moving your mail from your old account if necessary. This document contains information that pertains to the Microsoft Outlook client, but several sections are not client specific.
# Table of Contents

<table>
<thead>
<tr>
<th>New Features</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• E-mail Quota</td>
<td>3</td>
</tr>
<tr>
<td>• Viewing Your E-mail on the Internet</td>
<td></td>
</tr>
<tr>
<td>• Calendaring</td>
<td></td>
</tr>
<tr>
<td>• Safety Features against Viruses and Malicious Content</td>
<td></td>
</tr>
<tr>
<td>• The Out-of-Office Assistant</td>
<td></td>
</tr>
<tr>
<td>• Recovering E-mail That You Have Deleted in the Last 30 Days</td>
<td></td>
</tr>
<tr>
<td>Contact Information &amp; Possible Revisit Date</td>
<td>4</td>
</tr>
<tr>
<td>Checking the Size of Your Exchange Mailbox</td>
<td>5</td>
</tr>
<tr>
<td>Storing Sent Items Locally</td>
<td>6</td>
</tr>
<tr>
<td>Safety Features Against Viruses and Malicious Content</td>
<td>7</td>
</tr>
<tr>
<td>Proper Ways to Handle Potentially Unsafe Files</td>
<td>8</td>
</tr>
<tr>
<td>Setting up the Out-of-Office Assistant</td>
<td>9</td>
</tr>
<tr>
<td>Recovering E-mail That You Have Deleted in the Last 30 Days</td>
<td>10</td>
</tr>
<tr>
<td>Public folders</td>
<td>11</td>
</tr>
<tr>
<td>The Global Address List (GAL)</td>
<td>12</td>
</tr>
<tr>
<td>Checking Messages using OWA</td>
<td>13</td>
</tr>
<tr>
<td>Moving Mail from your Old Account</td>
<td>18</td>
</tr>
</tbody>
</table>
New Features

E-mail Quota
Your storage limit for e-mail and attachments is now 50MB by default. This is more than double the default amount that was allotted to your old account. When you have reached your quota you will receive a message from the system notifying you to 'clean up' your mail that is stored on the server. At 75MB you will no longer be able to send e-mail and at 100MB you will no longer be able to send or receive e-mail. You should, however, keep track of the amount of mail you have on the server before you receive this notice. The e-mail that you send is stored on the Exchange server by default and counts against your quota. You can choose to store your sent items locally, realizing that you will not be able to view these messages from another computer.

Viewing Your E-mail on the Internet
You can now view your e-mail from any computer in any location using a web browser such as Internet Explorer or Netscape and browsing to OWA (Outlook Web Access).

Calendaring
Exchange comes with a calendaring feature built-in. Meeting invitations are sent automatically via e-mail, and entered into your calendar automatically as you accept them.

Safety Features against Viruses and Malicious Content
Some versions of Outlook are setup to block files that may contain viruses and or malicious content. Instructions are included that explain the types of files that are generally blocked and how to receive these types of files from legitimate sources.

The Out-of-Office Assistant
The Out-of-Office Assistant is a feature that is accessible in Microsoft Outlook, with a MAPI connection or OWA only. The assistant allows you to have an automatic reply sent to persons notifying them that you are out of the office for whatever reason.

Recovering E-mail That You Have Deleted in the Last 30 Days
This feature is only available if you are using Microsoft Outlook, with a MAPI connection or OWA. You can now recover an e-mail that you have deleted in the last 30 days without having to call the HelpDesk to request a restore from the Systems Team.
Contact Information & Possible Password Change

If you have any questions or need any assistance with the instructions included in this packet please contact the HelpDesk.

- Phone: 475-HELP,
- TTY: 475-2810
- In Person: Gannett Building, Room 7B-1113.

☐ If the box to the left has been checked your RIT Account and/or computer password has been changed. The temporary password is __________________________. You will have to change your password ASAP at the following location: https://start.rit.edu. This will change the password for your RIT Account as well as the password you use when you log into your computer and Exchange mail.

If you have any problems changing your password or updating your e-mail client please contact the HelpDesk for assistance.

Technician _____________________________ Date______________

Revisit Date if Applicable ________________

Notes:

☐
Checking the Size of Your Exchange Mailbox

1. Right click on your Exchange Mailbox, which is the very top level, and choose ‘Properties for Mailbox <Your Name>’ from the pop-up menu.

2. On the Mailbox Properties window click the ‘Folder Size’ button.

3. On the Folder Size window you will be able to view your total mailbox size in kilobytes (KB). You divide the total number by 1024 to figure out how many MB [megabytes] are being used. This window will also show you the size of each folder individually. If you don’t need to know the exact size you can just remove the last 3 digits (e.g. 9000KB = 9MB)
Storing Sent Items Locally

When you send e-mail using an Exchange account a copy of the sent mail is stored in the ‘Sent Items’ folder under your Exchange account. These stored e-mails will count against your quota. You can either delete the sent e-mails to save space or move them to the ‘Sent Items’ folder that is stored locally on your computer. If you choose to move the e-mails locally you will not be able to view them from a remote location and you will be responsible for backing them up. You may to only save items that are important to you and delete all others.

1. Deleting Sent E-mail:
   - Click on the ‘Sent Items’ folder under the Exchange Mailbox to highlight it and then click on Edit from the toolbar and choose ‘Select All’ from the drop down menu.
   - This will highlight all of the e-mail in your ‘Sent Items’ folder
   - Click the ‘Delete’ key on your keyboard
   - If you only want to delete individual sent e-mails just click on the individual e-mail and hit delete

2. Moving Sent E-mail to the ‘Sent Items’ folder that is stored locally on your computer:
   - Follow the instructions from above to highlight either all or individual e-mails in the ‘Sent Items’ folder under your Exchange account
   - While the item(s) are highlighted right click and choose ‘Move To Folder’ from the drop-down menu
   - Click the + sign next to ‘Personal Folders’ to view all of the sub-folders.
   - Select the ‘Sent Items’ folder under ‘Personal Folders’ and click ‘OK’
   - This will move all or any individual e-mails from the Exchange mailbox to the local folder on the computer.
Safety Features Against Viruses and Malicious Content

Some versions of Outlook are setup to block files that may contain viruses and or malicious content. This is definitely true if you are using Outlook XP or Outlook 98/2000 with the latest security updates. Some of the more common files that are blocked end in the following extensions [listed in the table below]. A file extension is the part of the file name that comes after the dot [an example is file1.exe where file1 is the file name and .exe is the extension]. This is not a full list of the types of files, but only the most common. A full list can be provided upon request, but it is safe to assume that if you see one of the ‘Unsafe’ messages provided in the screenshots below it is on that list.

<table>
<thead>
<tr>
<th>.ade</th>
<th>.adp</th>
<th>.asx</th>
<th>.bat</th>
<th>.com</th>
<th>.exe</th>
</tr>
</thead>
<tbody>
<tr>
<td>.hta</td>
<td>.inf</td>
<td>.mdb</td>
<td>.msi</td>
<td>.url</td>
<td>.vb</td>
</tr>
</tbody>
</table>

If you see the following message when you send e-mail your e-mail client will not allow it to pass through to the recipient; the person you are sending the e-mail to will not receive the attachment. Click ‘No’ to the pop-up message and then right click the attachment in your e-mail and select ‘Remove’ from the pop-up menu. Please review the section on ‘Proper Ways to Handle Potentially Unsafe Files’ below.

If you open an e-mail that has an attachment and see the following message “Outlook blocked access to the following potentially unsafe attachments: <attachment name>” in yellow the Outlook e-mail client has prevented the attachment from reaching your mailbox. Review the section on ‘Proper Ways to Handle Potentially Unsafe Files’ below.
Proper Ways to Handle Potentially Unsafe Files

If you are trying to send e-mail with a potentially unsafe file attached follow the instructions below.

1. First you should make sure that you are able to view file extensions on your computer. To check this take the following steps:
   • Double click the ‘My Computer’ icon on your desktop
   • Click ‘Tools’ on the toolbar and choose ‘Folder Options’ from the drop down menu
   • When the ‘Folder Options’ window opens click on the ‘View’ tab
   • Look for the ‘Hide file extensions for known file types’ listing and make sure that the box in front of it is not checked
   • If the box is checked click on it to remove the checkmark and then click ‘OK’ to close the window and then close the ‘My Computer’ window

2. You must rename the file before you attach it by browsing to the file’s location, right clicking the file and choosing ‘Rename’ from the pop-up menu. You should jot down the full name of the file before you rename it in case you cannot remember what the extension was after you’ve changed it.
   • The file name will now be highlighted; click once inside the highlighted box and use the backspace key to remove the file extension [see paragraph 1, the section in bold, for an explanation of what a file extension is if necessary].
   • Rename the file extension to .txt [e.g. file1.exe becomes file1.txt].
   • Click outside of the file name box in any blank area of the window and say ‘Yes’ to the pop-up warning. Click ‘Yes’ again if you are prompted with a confirm change pop-up.
   • Your file is now ready for you to send!
   • Attach the file, as you normally would, send your e-mail and then follow the steps above to change it back to the previous file extension. This seems difficult at first, but after you’ve done it once or twice it will become much easier.

If you are unable to open an attachment, from a reliable contact, follow the instructions below.

1. Reply to the sender and explain that you are not able to receive these types of files.
2. Include the instructions above on how they should attach these types of files in the future. The ITS HelpDesk can provide an electronic version of these instructions upon request.
3. After they have resent the file save it locally to your computer and change the file extension back to what it should be. The actual file name and extension appears in the original e-mail that you received from them in the yellow section.
**Setting up the Out-of-Office Assistant**

The Out of Office Assistant is a feature that allows you to notify other RIT Exchange users when you are away from the office. You can also use the Out of Office Assistant to notify anyone sending you e-mail that you are out of the office. The difference is that Exchange users, using the Microsoft Outlook client, will only receive 1 notice, whereas other persons outside of the RIT Exchange environment will receive a notice each time they send you mail.

When someone sends you an e-mail the Out of Office Assistant feature automatically responds to the item with a notice, indicating that you are away from the office. The notice can also display any text that you choose to send; including the dates and times you are out of the office, any additional information, such as who to report to with questions. The notice is sent only once to each person that sends you an item.

1. From the Main window, pull down the Tools menu and select Out of Office Assistant.
2. Select I am currently Out of the Office.
3. In the box under AutoReply only once to each sender with the following text, type the message you want to send to people.
4. Click OK.

When someone sends you an email message, they will automatically receive an email message from you containing the text you wrote about being out of the office.

Your message will be stored on the Exchange server until you turn off the Out of Office Assistant. To turn off the Out of Office Assistant, pull down the Tools menu, select Out of Office Assistant and select I am currently in the Office. If you forget to turn it off, you will be prompted the first time you open Outlook after returning.
Recovering E-mail That You Have Deleted in the Last 30 Days

If you need to recover e-mail or folders that you’ve deleted in the last 30 days from your Exchange account you may do so by following the steps below. With the new e-mail system when you empty your deleted items folder the Exchange server keeps a copy of the e-mail or folder for 30 days. These items do not count against your e-mail quota. This feature is only available if you are using Microsoft Outlook.

1. Click on your ‘Deleted Items’ folder under the Exchange mailbox and then click ‘Tools’ and select ‘Recover Deleted Items’ from the drop down menu.

2. When the ‘Recover Deleted Items’ window opens click on the deleted item you would like to recover and then click on the envelope with and arrow icon and the item will be moved back into your ‘Deleted Items’ folder under your Exchange account. You may then move the item to another folder or empty it from your ‘Deleted Items’ folder when you are done reviewing it.
Public folders

You will notice a new section under your ‘Folder List’ called ‘Public Folders’. Public folders are created to share information with others. The owner of a public folder can set permissions so that only a select group of people can read, post, edit and delete information; or a public folder can be set to be available to anyone in the Exchange environment.

Currently the Public Folders in our Exchange environment are a work in progress. Eventually each Organizational Unit (department, college, etc.) in the Main domain will have its’ own Public Folder. You can use these public folders to share e-mails with others in your group, or post information instead of e-mailing each individual person.

Other Organizational Units within the Exchange environment may have information that they want to share with the entire university. This can be posted in a section of their public folder that they’ve made available to everyone in the Exchange environment. Two such folders that are already available are the ALLSTAFF@rit.edu and RITSTAFF@rit.edu public folders. These two public folders contain a copy of all e-mails sent to each of their respective mailing lists. You now have the option to remove yourself from the RITSTAFF mailing list, because you can check the postings in the public folder instead. If you’d like to remove yourself from the RITSTAFF mailing list please go to: http://inside.rit.edu/lists/ritstaff.html and follow the link to unsubscribe.

The location of these two public folders is ‘Public Folders\All Public Folders\Services\Mailing List Archive\Faculty & Staff Lists’. You will have to drill down (click the + sign next to each public folder) to the public folders to reach them.
The Global Address List (GAL)

This address book contains a list of user names and e-mail addresses for all persons in the RIT Exchange environment. Additional information such as title, department and phone numbers may be listed for each user as well.

The GAL can be accessed by clicking on the Address Book icon or by clicking ‘Tools’ and selecting ‘Address Book’ from the drop-down menu.

We have configured your ‘Contacts’ list to appear in the Address Book first, but you can view the list of persons in the GAL by clicking the down arrow in the ‘Show Names from the:’ box and selecting ‘Global Address List’

You can also search for persons at RIT who are not in the Exchange environment by selecting LDAP from the pull-down list and then clicking ‘Tools’ and selecting ‘Find’. This will open the ‘Find’ window where you type in the person’s name and click ‘OK.’

Sending E-mail to Multiple Persons

One thing to keep in mind, especially for those persons who were former Netscape users, is that you cannot separate e-mail addresses in the ‘To’ field of a message with a comma. You have to use a semi-colon. An example is provided below.
Checking Messages using OWA

owa (Outlook Web Access) allows you to check your messages over the Internet from any computer. Your browser must have 128-bit encryption. If you have trouble opening your account check to make sure that your browser has 128-bit encryption first. You can do this by clicking 'Help' on the toolbar and then choosing 'About [Your Browser Name]' from the drop down menu. The information on encryption should be displayed. Most current browsers support 128-bit encryption.

- In your browser enter the address: https://mymail.rit.edu/exchange/
- If you are prompted with a security certificate pop-up say 'Yes' [Internet Explorer] or 'Continue' [Netscape] to proceed

Internet Explorer Example

Netscape Example

- Enter your Active Directory user name as main\user name and your password and choose whether or not to save them

You can also check messages from home using a client such as Outlook, Outlook Express or Netscape. You will need to have VPN installed on your machine to do this. Instructions are publicly available at the ITS web site http://www.rit.edu/its or you may request them by calling the ITS HelpDesk at 475-HELP or TTY 475-2810.
Checking Messages using OWA (cont.)

You will find that the OWA client looks very similar to Outlook. Below is a screen shot of what it looks like as well as a description for some of the more common functions.

![Screen Shot of OWA Client]

**Figure 1**

**Toggle between folder view and shortcut view**

**Send a new e-mail message, reply to a message, reply to all persons addressed in the original message or forward an e-mail message**

**Check for new messages**

**Search for messages by subject, sender, etc. Can also search on items such as contacts, calendar, etc.**
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Move" /></td>
<td>The move button allows you to move items between different folders, instead of clicking and dragging</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
</tr>
<tr>
<td><img src="image" alt="Empty" /></td>
<td>Empty the deleted items folder</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview Pane, allows you to preview the text of a message without having to double click to open it</td>
</tr>
<tr>
<td><img src="image" alt="Address" /></td>
<td>Address Book, only allows you to search for persons in the Global Address List (other Exchange users), not your personal contacts</td>
</tr>
<tr>
<td><img src="image" alt="Sort" /></td>
<td>Allows you to sort your messages by all, unread, sender, etc.</td>
</tr>
</tbody>
</table>

You can toggle between the ‘Folders’ view (see figure 1) and a ‘Shortcuts’ view (shown to the left). The ‘Shortcuts’ view is very similar to the Outlook Bar in Outlook. One function you will use on the ‘Shortcuts’ screen is ‘Options’. Options allow you to perform special functions such as setting the ‘Out of Office Assistant’, notifications options and recover deleted items. The ‘Change Password’ option does not work and that is by design.
When you look at your contacts in OWA you may notice that some of them do not have a title or name. This is because only the display name has been entered and not the actual first and last name. This issue is easily resolved.

Open Outlook, Double click on the contact with the blank title to open the information for the contact. Click on the button that says ‘Full Name’ and you will notice that it is blank. Fill in the first and last name and then click ‘OK’ and the title for the contact should now be displayed.

To send an e-mail using OWA click on the ‘New’ button. A window will open like the one in figure 1.

Either fill in the e-mail address of the recipient if you know it, their name as it appears in your contacts or click the ‘To’ button to search the Global Address List and enter your search criteria (figure 2) in the ‘Find Names’ window.

You can search on ‘Last Name’, ‘First Name’ or ‘Display Name’.
Moving Mail from your Old Account

You cannot simply drag and drop entire folders from an IMAP account to an Exchange account. There are certain permissions on the IMAP folders that will not allow you to view the messages when checking e-mail using the OWA application (Outlook Web Access - checking your e-mail using a browser). You also should not move more than 500KB worth of e-mail messages at a time. This puts too much of a payload on the server and can also corrupt your e-mail in the process.

1. First you should create a folder on the Exchange account to move the e-mail into. You should give it the same name as the folder on the VMS/OSF account. If you are moving messages from the ‘Inbox’ on the VMS/OSF account to the ‘Inbox’ on the Exchange account it is not necessary to create a folder as one already exists (please move on to step 2).
   a. You create the folder by right clicking on ‘Outlook Today [Mailbox xxx]’ and choosing ‘New Folder’ from the drop-down menu
   b. When the ‘Create New Folder’ window appears type in the name of the folder you are creating, make sure that ‘Mailbox – xxx’ is selected and click ‘OK’.

2. Right click on the folder, which contains the VMS/OSF mail that you are going to move and select ‘Properties’. When the properties window appears click the ‘Folder Size’ button to see how large the folder is [you may want to review the ‘Checking the Size of Your Exchange Mailbox’ document].
   a. If the folder is under 500KB total than you can move all of the e-mail messages at once, if it’s over 500KB than only move 500KB or less at a time.
   b. If the folder is over 500KB you should make sure that you view the size of individual e-mail messages. You should see a column called ‘Size’.
      i. If you cannot see the column called size make sure that Outlook is enabled to view it by doing the following:
         a. Click ‘View’ from the toolbar
         b. Choose ‘Current View’ from the drop-down menu
         c. Choose ‘Customize Current View’ from the next drop-down menu
         d. Click the ‘Fields’ button on the ‘View Summary’ window
e. Under the ‘Available Fields’ window on the left-hand side click on ‘Size’ to highlight it. If you do not see ‘Size’ on the left hand side then it should be listed on the right hand side and you can move to step ‘g’ below

f. Click the ‘Add ->’ button to move it to the ‘Show these fields in this order’ window on the right hand side

g. Click on the ‘Move Up’ button until ‘Size’ is at the top and click ‘OK’ and then ‘OK’ again to return to the main Outlook window

h. Size should now be the first column

3. You can now highlight the messages you want to move and then drag them into the new folder or that you’ve created or the ‘inbox’ under the Exchange account.

4. When you are all done moving e-mail from the folder you will notice that they have a line through them. You must purge the moved messages from your old account before moving on to the next folder.

   o Click ‘Edit’ and ‘Purge Deleted Messages’ messages from the toolbar to clear all of the moved e-mail.